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Desktop Productivity on the Mac
We all love our Macs.  I know I do.  Ever since I first heard about Macintosh 

back in 1984 I wanted one.  The design was unique and mesmerizing.  The sales 
pitch was flawless … remember the “1984” Super Bowl commercial (https://
www.youtube.com/watch?v=VtvjbmoDF-I)?  It has been consistently recognized 
as the greatest TV commercial ever.

I finally got my first Mac from my employer of the time in exchange for 
overtime work back in ’94 or ’95.  It was used and a bit of a Frankenstein … a 
Macintosh II with a motherboard upgrade to a Macintosh IIfx (the most 
expensive, “wicked fast” Macintosh ever … far more in 2017 dollars than the 
iMac Pro released late last year).  If you are interested in geeky computer history 
you can read about it here: https://en.wikipedia.org/wiki/Macintosh_IIfx. I 
loved it, and I have bought many Macs and other Apple products in the years 
since.

We buy Macs for many reasons.  They look good.  They have an aura of 
coolness.  Our friends, colleagues, and family members recommend them.  Steve 
Jobs hypnotized us in a masterful marketing ploy to buy them! 

https://www.youtube.com/watch?v=VtvjbmoDx-I
https://www.youtube.com/watch?v=VtvjbmoDx-I
https://en.wikipedia.org/wiki/Macintosh_IIfx
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Whatever the reason, we love our Macs.  
But once that big slab of aluminum and glass is sitting on your desk or on 

your lap, it is time to use it to get things done.  Email your family and friends.  
Clean up and archive the photos from your latest vacation.  Search the web for 
your next vacation destination.  Write the Great Canadian Novel you have been 
promising to yourself to do for the last 10 years.  Create and edit a movie.  And 
so much much more.

Because of their power and flexibility we can do a lot on our computers.  The 
on-line world and what we can accomplish on it grows every day.  Many of us 
are constantly flipping between applications and websites; creating or searching 
for and then viewing and modifying text, image, audio and video files.  Word/
Pages and Excel/Numbers are our frenemies.  Safari/Chrome/Firefox our 
gateway to the digital universe.  iTunes … well we have to live with that one.

Unlike five or ten years ago, anything you can do today on a Windows PC 
you can also do on a Mac.  If a particular Windows program is not available on 
the Mac, it is a pretty safe bet that an equivalent program with 90%+ of the same 
features is available for the Mac.  With the ever growing popularity of web-
hosted applications, Cloud Computing (see https://en.wikipedia.org/wiki/
Cloud_computing for a description) and similar platform-agnostic solutions we 
are unlikely to see a resurgence in Windows-only (or Mac-only, for that matter) 
applications.

Historically one of the biggest advantages the Mac has had over Windows 
PCs has been the consistency of the User Experience (aka “UX”) across 
applications.  Users just find it easier to do things on a Mac.  Apple has put in a 
lot of effort to provide developers with tools and features that encourage this 
consistency.  Although Microsoft and third-party software vendors continue to 
close the gap (visually, Windows 10 is quite attractive), there still remain a vast 
number of “our way or the highway” mission-critical Windows applications out 
there.

For the end user the Mac UX advantage often means that learning how to do a 
specific action in one program will translate to the same action triggering a 
predictable result in a different program.  Program menu bars are all similar and 

https://en.wikipedia.org/wiki/Cloud_computing
https://en.wikipedia.org/wiki/Cloud_computing
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expose the same functionality to the user in the same location.  Standard dialogs 
like File Open, File Save, Find, Print, et cetera all look very similar if not identical 
across most applications.  

This UX consistency has also fostered in the Mac environment a vast number 
end-user productivity tools and tricks.  Something about the Mac has lead to 
smart people coming up with creative and unique ways to improve how we use 
our Macs; reducing the friction that can otherwise slow us down and cause 
frustration.  They write new programs to allow users to do things more 
efficiently.  They investigate Apple’s and other developers’ existing tools and 
tricks and improve upon them, saving a manual step here or a mouse click there.  
They then share their inventions or improvements across the Mac world.  

This document is my small attempt to add to the sharing…
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Document Conventions
Throughout this document I constantly refer to keyboard shortcuts and hot 

keys.  To keep things consistent I use the following conventions to describe such 
non-alpha-numeric keys:

⌘ Press the COMMAND key
⌥ Press the OPTION key (ALT on some keyboards)
⌃ Press the CONTROL key (CTRL on some keyboards)
⇧ Press the SHIFT key
↩︎ Press the RETURN key (ENTER on some keyboards)
␛ Press the ESCAPE key
␣ Press the SPACE key
↑ Press the UP arrow key
↓ Press the DOWN arrow key
→ Press the RIGHT arrow key
← Press the LEFT arrow key
⌫ Press the DELETE key
⇥ Press the TAB key
Fn Press the numbered FUNCTION key (typically F1 to F12)

Combination keypresses are expressed as a single “word”.  For instance, 
pressing CONTROL + COMMAND + SPACE all together will be presented as: 
⌃⌘␣
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MacOS Built-in Productivity Features
Overview of Built-In Features

MacOS proves a plethora of features and tools to make the time spent using a 
Mac more productive.  In the following sections we will take a look at several of 
these and provide use cases for how they can be used to improve our efficiency.

Keyboard Shortcuts
Some of the most productive things you can learn on your Mac are the most 

used keyboard shortcuts available in your apps.  Shortcuts make you more 
efficient and productive.  The only way for these to become second nature is to 
memorize them, and then practice until your fingers automatically move when 
you think of the corresponding action. Learn any of the following and you will 
save time and mental energy while using your Mac!

Hint: pick a few — 3 or 4 — of the following shortcuts that might be useful, write 
them down on a Post-It Note as a reminder, and attach that to your display 
(without obscuring the screen!).  Force yourself to use these shortcuts until they 
become second nature. Once they are automatic you can pick a few more, replace 
the Post-It Note, and start practicing the new ones.

Finder
The Finder is just an app (albeit a very critical one) and it has a multitude of 

keyboard shortcuts:
◆ ⌘N opens a new Finder window.
◆ ⌘M minimizes that window.
◆ ⌘T opens a new tab once you’re in a window.
◆ ⌘W closes the current tab, or window, if it’s the only tab.
◆ ⇧⌘N creates a new folder.
◆ ⌘1/2/3/4 lets you move through different views (icon/list/column/

cover flow).
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◆ Pressing ↩︎ while a file is selected allows you to change its name. Press ↩︎ 
again to confirm or ␛ to cancel the name change.

◆ The ␣ shows you a preview of any file.
◆ The arrow keys (↑↓→←) allow you to move from file to file.
◆ Holding down ⇧ while you press the arrows (↑↓→←) allows you to mark 

multiple files.
◆ ⌘⌫ sends all marked files to Trash.
◆ ⌘⇥ lets you flip through all open applications and select the one you’d 

like to view.

While Typing
All apps implement the same set of basic shortcuts while you are typing and 

manipulating text.  Apps like TextEdit, Notes, Evernote, the Microsoft Office 
suite (Word, Excel, PowerPoint), the iWork apps (Pages, Numbers, Keynote) … 
any app that captures text … all implement the following:
◆ ⌘→ jump to the end of the current line.
◆ ⌘← jump to the beginning of the current line.
◆ ⌥→ jumps to the next word.
◆ ⌥← jumps to the previous word.
◆ ⇧→ selects the next letter or symbol.
◆ ⇧← selects the previous letter or symbol.
◆ ⌥⇧→ selects the entire next word.
◆ ⌥⇧← selects the entire previous word.
◆ ⇧⌘→ selects everything right of the cursor to the end of the line.
◆ ⇧⌘← selects everything left of the cursor to the end of the line.
◆ ⌘C copies whatever is highlighted.
◆ ⌘V pastes whatever was last copied.
◆ ⌫ or ⌘X deletes whatever is highlighted.
◆ ⌘Z undo typing.
◆ ⇧⌘Z redo typing.
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Spotlight
Spotlight is macOS’s built in all-in-one search tool.  It can be used to find files, 

folders, applications, images, music, web links and almost anything else stored 
on your Mac, and to directly open these items without having to first go to the 
Finder, Dock, or any other application.

Using Spotlight you can search a multitude of sources:

◆ Applications ◆ Images
◆ Bookmarks & History ◆ Mail & Messages
◆ Calculator ◆ Movies
◆ Contacts ◆ Music
◆ Conversions ◆ Other
◆ Definition ◆ PDF Documents
◆ Developer ◆ Presentations
◆ Documents ◆ Spotlight Suggestions
◆ Events & Reminders ◆ Spreadsheets
◆ Folders ◆ System Preferences
◆ Fonts

Through the Spotlight System Preferences Pane you can enable or disable 
Spotlight’s searching of each of these sources.

Pressing the Magnifying Glass icon  in the menubar or the keyboard 
shortcut ⌘␣1 will open the Spotlight Search dialog:

Start entering any search term and after a second or two the dialog will 
expand to display (usually) multiple possible matches:

1 The default shortcut is ⌘␣.  This can be modified in Preferences → Keyboard → 
Shortcuts.  Details are provided later in this document.
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Hit ↩︎ to select the default match (in the above example, to launch iTunes) or 
use↑/↓ or your mouse or trackpad to navigate to a better match.  Hit ↩︎ (or click) 
when you have highlighted the desired match.

To dismiss the Spotlight search results without taking action press ␛.
The right hand side of the results pane displays additional information about 

the currently selected match.  As you switch between the matches in the left side 
the right side will update.  For some matches the right will display additional 
matches.  For instance, when the left hand match is an application, the right hand 
will list the most recent documents associated with that application.  As an 
example, when searching for “Pages”:
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The right hand lists (in this example) 9 recently opened Pages documents.  To 
jump over to the right hand side of the pane press ⇥ or use your mouse/
trackpad to move the cursor over to the list.  Once there you can move up and 
down the list using the ↑/↓ keys or use your mouse or trackpad to navigate to 
the desired document.  Press ↩︎ (or click) when you have highlighted the desired 
match.  To return to the left hand side of the dialog press ⇧⇥.  

Text entry/matching is dynamic.  Enter more text to refine the search.  Insert 
or delete characters to modify the search string and the matching hits will update 
accordingly:

NOTE: Sometimes the returned hits may seem out of place.  For instance, why 
does a search for “ic” return as its second TOP HIT “Calendar”?  (The answer is 
that the file format used for calendar events has the extension “.ics”).  I find that 
you sometimes have to go with the flow on these matters…

Shortcuts to Activate
The default keyboard shortcut is ⌘␣.  This can be modified using the System 

Preferences→Keyboard→Shortcuts tab:
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Mission Control and Spaces
If your desktop is cluttered with open app windows, you can create 

additional desktops, called Spaces, to organize these windows. When you work 
in a Space, you will see only the windows that are assigned to that space - open 
windows assigned to other Spaces are not displayed.  A common use is to have a 
separate Space for all the windows associated with one application, or only the 
windows of a small number of related or collaborating applications.  This keeps 
your attention focused on the job at hand by limiting your attention to only these 
related windows.

Mission Control allows you to navigate between your Spaces through a 
graphical interface.  It shows all of the windows open in that Space, neatly 
arranged so it’s easy to find the one you need. All configured Spaced and any full 

screen applications (created by pressing the full screen  button in the upper 
left corner of the application’s window) are shown in the Spaces bar along the 
top edge of the screen.

You can configure a variable number of Spaces — up to 16 may be enabled, 
however I find I typically have somewhere between 4 and 8 Spaces/full screen 
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apps open at any time.  As an example, my typical Mac has the following open at 
any time:

◆ My mail app and calendar app split-screen in one Space
◆ My writing application, Scrivener, open in a Space
◆ My PDF reader, PDFPenPro, open in a Space (for viewing research)
◆ The Terminal app open in a Space (I am an old-time UNIX geek)
◆ One or two additional “scratch” Spaces that I use to hold transient 

applications.  Into these I will have open:
◆ Finder
◆ Pages/Numbers
◆ Photos / Photo editing applications 
◆ Xcode

◆ Safari in full screen mode
◆ iTunes in full screen mode

I could not imagine having all these applications open at one time all sharing 
one screen.  For me Mission Control and Space are productivity boosters (and 
help to maintain my sanity).

Launching Mission Control
There are multiple ways to launch Mission Control:

1. Click on the Mission Control icon (by default included in the Dock but 
always available from the Applications folder):

2. On the standard Mac keyboard you can press F3.
3. If you have a Trackpad you can open Mission Control by a 3-Finger 

swipe-up.
When you activate Mission Control the Menu Bar at the top of the display will 

change to list all the available Spaces along with any full screen applications:
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To see a thumbnail of each Space move the cursor into the Spaces bar:

In addition to Spaces, all Full Screen Apps are also displayed in the Spaces bar 
(in the above screen capture, Safari is in full screen mode).

You can re-order the Spaces by Clicking and Dragging on the thumbnail in the 
Spaces bar at the top of the Mission Control screen.

While in Mission Control you can move between Spaces using the ⌃→ and 
⌃← keyword shortcuts.  Clicking on a Space of full screen app in the Spaces bar 
will: 

◆ Exit Mission Control 
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◆ Open the selected Space or app
If a Space has multiple overlapping windows displayed in it, the Mission 

Control view of that space will uncover all the overlaps and display a (possibly 
reduced size) image of each window.  

Clicking on any of the windows in the Mission Control view will:
◆ Exit Mission Control
◆ Open the Space on the Display
◆ Bring the selected window to the front

Adding and Deleting a Space
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To ADD a Space click on the “+” button on the far right side of the Spaces bar.
To DELETE a Space roll the cursor over the space to be deleted and wait a 

second or two until the Delete button (an “X”) appears in the upper left corner.  
Click on the “X” to delete the space.  To cancel the delete operation click outside 
the bar.

System Preferences Pane
System Preferences→Mission Control:
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The default Keyboard shortcut is F3.  You can map this to a different key if 
desired .

Application Switching
Like all modern operating systems, macOS supports running several 

programs at the same time.  Switching between programs can be accomplished in 
multiple ways.  Traditionally most people change applications via clicking on the 
app icon in the dock:

If you want to keep your hands on the keyboard there are a couple of quicker 
options. 

Switch to another Application
Switch to another application by using the ⌘⇥ and ⇧⌘⇥ hot key 

combinations.  Pressing either key combination the first time opens a navigation 
bar displaying all currently running applications:

The applications are order with the most recently viewed application on the 
left and longest not viewed application on the right.  You then can cycle through 
all the applications listed by repeatedly pressing one of the two hot keys:

⌘⇥ Select the application to the RIGHT of the current selection
⇧⌘⇥ Select the application to the LEFT of the current selection

Upon reaching either end of the list, another press of the same hot key combo 
will wrap you around to the opposite end of the list.
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Once you have reached the application you want to switch to, release the key 
combo to switch to the selected application.

TRICK: Once the navigation bar is displayed, if you keep the ⌘ key pressed you 
can use the → and ← keys to move through the list. You may find this more 
convenient that repeatedly pressing ⌘⇥ or ⇧⌘⇥.  Releasing the ⌘ key will 
switch to the currently selected application.  

Switch to another Space/Full Screen Application
If you organize your applications into separate Spaces you can cycle between 

the Spaces via Mission Control or by using the ^← and ^→ key combinations.

Hot Corners
Moving the cursor to any of the screen’s four corners can automatically 

activate one of several pre-defined actions:

Simply move the cursor to the desired corner and wait a second or so and the 
assigned action will be activated.

Available Actions
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Click on the pop open button on each corner to configure.  The available 
actions are:

Mission Control Opens Mission Control.  This is very convenient if you do not 
have a trackpad.

Application 
Windows

Displays all application windows displayed on the current 
screen.  This will reduce the display size of all windows so that 
they are visible with no overlap similar to how Mission Control 
operates.  Clicking on any window will restore all to their 
previous size with the selected window on top

Desktop Shows the desktop.  Slides all the open application windows off 
screen, leaving a handle to each window on the display edge.  
Click on any of the handles to restore all application windows

Dashboard Switches to the Dashboard screen (if enabled)
Notification Center Opens the Notification Centre sidebar

Launchpad Opens Launchpad
Start Screen Saver Immediately starts the screen saver

Disable Screen 
Saver

Disables automated launching of the screen saver

Put Display to Sleep Activates the display sleep (energy saver) feature
– Take no action on this corner

Configuring Hot Corners
Hot Corner configuration is available in the following System Preferences 

panels:
1) Desktop & Screen Saver→Screen Saver Tab
2) Mission Control

Open one of these configuration panels and click on the desired corner’s 



18

drop-down, mouse over the desired action, and then release the mouse button to 
assign the action to that corner.

Text Substitutions (AKA “Snippets”)
Text Substitutions allow you to configure the system to automagically swap a 

(usually short) text string with another (often longer) text string.  This is a useful 
feature for common items like phone numbers or addresses — text strings that 
you will often want to enter but would rather do so with less typing away at the 
keyboard.

You configure text substitutions in the System Preferences→Keyboard→Text 
tab:

When choosing a string that you want to replace, be careful to choose 
something that you would not otherwise enter (perhaps as a part of another, 
longer word or string) … otherwise you may find your self having to cancel the 
substitution when you enter the to be replaced string.  A common approach to 
solve this issue is to prefix the string with a common, unusual string.  In the 
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above all strings start with “x.”
It must be noted that the feature as implemented by Apple in macOS is very 

limited in functionality … the replacement strings are quite literal, with a VERY 
limited ability to format and no ability to take advantage of a computer’s text 
processing capabilities.  

Alternatives
The next level of snippet functionality is available in applications like Alfred 

(https://www.alfredapp.com) or Keyboard Maestro (https://
www.keyboardmaestro.com/main/), which offer better, more flexible 
functionality.  In both of these examples snippet processing is just one of the 
features provided.

If you want to “go to town” with an application that takes text expansion all 
the way to Eleven, take a look at TextExpander (https://textexpander.com).  
TextExpander includes several significant features not included in any of the 
other applications discussed in this document.  One thing to keep in mind when 
considering TextExpander is that it is a subscription service, so you will be 
paying a monthly (or yearly) recurring fee to use it.

Preview File Contents
Most Mac users are aware of two ways to view the contents of a file without 

first having to open a separate application.  Are you aware of a third method, 
Quick View?

Column View
The first, and probably most used, method to view file contents in the Finder 

is to switch to Column View which, where possible, displays the contents of a 
selected file in the right-most column:

https://www.alfredapp.com
https://www.keyboardmaestro.com/main/
https://www.keyboardmaestro.com/main/
https://textexpander.com
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Music and Video files can also be previewed while in Column view by 
clicking on the play button in the right-most column:

Finally, several document formats like Pages, Numbers, Keynote, PDF, et 
cetera will also be displayed when selected, along with simple backwards/
forwards view buttons to review the file contents:
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Secret Tip: File content previews in column view is actually implemented using 
the Quick Look feature described below.

Cover Flow View
Cover Flow View will display file contents of images and other documents 

that have a graphic presentation.

Unlike Column view mode, while in Cover flow view mode you cannot 
preview audio or video files, or page through the contents of files other than the 
first page.
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Quick Look
If you want a larger view of the file contents you can use the Quick Look 

feature of macOS.  First select ONE OR MORE files in the Finder (any view) that 
you wish to take a close look at.  To select more than one file you can use the 
⌘Click feature.

Once selected press the ␣ key to open the file in the Quick Look viewer:

If you selected more than one file then use the ←/→ keys to switch between 



23

the files.
Quick Look works with dozens of file formats like audio files:

and video files:

For “live media” like audio or video files, the quick viewer will auto-play the 
media.

The number of supported file formats is impressive.  For many of the media 
formats which have “live” content (like audio or video) the Quick Look viewer 
includes the ability to play the media.
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Additional Options: Open with <preferred viewer>
Click on the “Open with <preferred viewer>” button in the upper right corner 

to open the selected image in the default viewer app.  For images and several 
other file formats the preferred viewer is the Preview application.

For other file formats the “Open with <preferred viewer>” button will change to 
open the default viewer for that file type.  These include:

◆ iTunes for audio files
◆ Quicktime Player or MPEG Stream Clip for video files
◆ TextEdit for text files
◆ Pages, Numbers, and Keynote for their respective file formats
◆ Et cetera

Additional Options: Do more with the Share sheet menu
Click on the Share sheet button to see additional actions you can perform on 

the file(s).
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Preview
Preview offers many features and useful functionality.  Here are a couple of 

the more useful ones:

Add Signatures to a PDF
Ever receive a PDF document that you need to fill in, sign and then return to 

the sender?  Well, Preview has the feature(s) necessary to perform all these steps 
and avoid having to print out the document for the signature step.

STEP 1: Capture Your Signature
The first step is to capture your signature into Preview.  To do so, open 

Preview and display the Markup Toolbar by clicking on the toolbar button (if 
displayed) or selecting View→Show Markup Toolbar:

In the Markup Toolbar click on the Sign dropdown button:
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You have two options to capture your signature: from a Trackpad (if attached) 
or using the Mac’s built-in camera.  I recommend the camera option.  

First write your signature on a sheet of unlined white paper. Click on the 
Camera tab of the signature popup.  Hold the signature up to the camera, 
properly framing it:
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Click on Done.  The signature is now captured and available for inclusion in 
documents:

Hint: when you configure your signature, consider also including your Initials, 
which are also often required when “marking up” a legal document.

STEP 2: Add your signature to a PDF Document
When you encounter a PDF document requiring a signature, just click on the 

Sign dropdown button and click on your signature (The Markup Toolbar must be 
displayed to see this option — see Step 1 above for instructions):
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A size-adjustable copy of the signature will be added to the document.  The 
signature background is transparent.  You can position and resize the signature 
as necessary using the edges and corners of the frame surrounding the signature:

Print Selected Pages
If you have a multi-page PDF open in Preview, and you want to only print a 

(possibly dis-continuous) subset of pages, you can do so easily using the 
following.  First, open the thumbnail sidebar:
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In the sidebar, ⌘Click on the page(s) you want to print:

Choose File→Print… (or type ⌘P), choose “Selected Pages in Sidebar under 
the Pages: option (by default, All will be selected), and then click on Print:
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It is just that easy!

Safari
Safari is a very capable browser with myriad options and configurable 

features.  Here are a few you may want to include into your workflows to 
improve your productivity:

Keyboard Shortcuts
Like most other apps, Safari supports a large number of keyboard shortcuts.  

Get to know the following common Safari (and most other browsers) shortcuts to 
improve your productivity:

◆ ⌘N opens a new window.
◆ ⇧⌘N opens a new incognito window.
◆ ⌘W closes the current tab or, once all tabs are closed, window.
◆ ⌘T opens a new tab and jumps into it.
◆ ⇧⌘T reopens the last tab you closed.
◆ ⌃⇥ moves to the next tab in your lineup.
◆ ⌃⇧⇥ moves to the previous tab in your lineup.
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◆ ⌘1/2/3… jumps to the first, second, third, etc., tab.
◆ ⌘9 jumps to whichever tab’s last.
◆ ⌘R reloads the page you’re on.
◆ ⇧⌘R reloads the page you’re on while bypassing the cache, 

meaning you can view it as if you arrived there for the first time.
◆ ⌘L jump to the URL/search bar from anywhere on the page.
◆ ⌘F allows you to start typing and find any word on a page.
◆ ⌘← goes back to the last page you visited.
◆ The ␣ scrolls down the current page in increments.
◆ ⌘P brings up the Print screen.
◆ ⌘M minimizes the current window.

Alternate Search Engines
By default all searches in Safari utilize Google.  Personal preference or a desire 

to improve privacy may lead you to want to change this.  Fortunately, there is a 
well known alternative — DuckDuckGo which provides results comparable to 
Google but does NOT track your search terms or results.

To change your default search engine, open Preferences→Search:

Click on the Search engine drop down:
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Choose DuckDuckGo (or one of the other search engines if desired):

Close the Preferences dialog.  All Safari search queries will now utilize the 
selected search provider:

HINT: Most browsers, including Firefox and Google Chrome, allow you to make 
similar changes (the supported search engines vary with each browser).

Pinned Tabs
Do you have “favourite” websites that you always go to?  Would you like to 

have them always open in Safari without having to manually open them every 
time you launch the browser?  Pinned Tabs are the solution.

To create a pinned tab, open the page in Safari as you normally would in a 
new tab (⌘T opens a new tab).  Once you have opened the page, right click on 
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the tab and select “Pin Tab”:

The tab will move to the left side of the tab bar and reduce in size, only 
displaying an icon instead of a site name:

Additional pinned tabs will be stacked up on the left.  You can drag around to 
reorder your pinned tabs just like other tabs, but you cannot intermix ‘normal’ 
and pinned tabs:

Closing and then re-opening the browser will ALWAYS restore the pinned 
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tabs in the same order as they were the last time the browser was closed.  Pinned 
tabs will reopen on the same page open when Safari was closed.  Also, the tab’s 
history will be retained so that the forward and back navigation buttons will 
operate as if the browser application had never been closed.

Attempting to close a pinned tab by, for instance, using the ⌘W Close Tab 
action, will NOT close a pinned tab.  The tab will remain open.  In order to 
permanently close a pinned tab you must right click on the tab and select “Close 
Tab” (or alternatively, select “Unpin Tab” and then subsequently close the now 
unpinned tab ):

Better Bookmarks
Managing your browser bookmarks can be a very personal thing.  Some 

people live their lives in chaos, never knowing where they are going or how to 
get there.  Others live structured and predictable lives, never putting a foot 
forward without first planning every step of the journey.  So it can be with your 
bookmarks: unorganized chaos or neatly structured and discoverable.  The 
following tips and tricks can help you be more productive using browser 
bookmarks.

◆ Use Favorites and the Favorites Bar
Your bookmarks will be more visible and accessible:
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◆ User Folders to organize your bookmarks
Determine a structure that fits your needs.  Organizing by topic or subject 

is usually a good place to start.  Create folders in your Favorites bar for 
your “top level” topics.  Optionally create Folders inside the top level 
folders for sub-topics.  Do not go wild with folders … too many levels can 
be as difficult to manage and navigate as no folders at all:

To create folders you must first enter edit mode … you can do so in the 
Bookmarks menu bar item or just press ⌥⌘B to open the bookmark 
editor.  The editor will open in the current browser window/tab:

You can then use the New Folder button in the upper right corner to add 
a bookmark.  Enter a name for the folder.  You can drag the folder around 
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in the hierarchy if it opens in the wrong location:

To rename a folder right click on it as choose Rename…:

To delete a folder you right click on the folder and choose Delete:

When finished editing your bookmarks you can close the window/tab or 
press the Previous Page button to reopen the current tab on the previous 
web page.

◆ Periodically review your bookmarks
Once a Month or once a Quarter review your bookmarks.  Cull the 

bookmarks you no longer use or need.  Move misfiled bookmarks to a 
better location in your bookmark hierarchy.  Put a reminder into your 
calendar as a recurring event and plan to spend no more than 5 or 10 
minutes reviewing them:
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◆ Use Bookmark Search to find and open bookmarks
Spotlight will search your bookmarks and allow you to open the 

bookmark in your default browser.  Alfred also supports searching your 
Google Chrome bookmarks.  If your style tends towards chaos, or you 
have a lot of bookmarks, then bookmark search can make your browsing 
life more productive.  Using Spotlight:

Hint: See later in this document for details on using Alfred to search for 

scrivlnk://261A57EB-D407-4B01-A8A6-CC93C6190917
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bookmarks.

Reading List
Reading List is the Safari implementation of a Read It Later service2.  Whereas 

the bookmark of a web page records a pointer (or address) of the page, a Read It 
Later service captures and stores either locally or in the cloud (or both) a copy of 
a web page.  This enables you to view the page later (hence the name “Read It 
Later”).  You can (optionally) save a copy of the page offline.  This enables you to 
see the page even when you are not connected to the internet — a very useful 
feature!

Note: Safari uses iCloud to keep your Reading List the same on all your Mac 
computers and iOS devices that have Safari Reading List enabled in iCloud 
preferences. Also, with iCloud, your Reading List and bookmarks are archived 
automatically, and you can restore them from an earlier version at any time.

There are two methods to save a web page to the Reading List:

1. Move the pointer to the Safari’s Smart Search Field.  A  symbol will 
appear on the left hand side and the field name will change to “Add page to 
Reading List”:

Click on the  to save the page to the Reading List.

2. Use the Bookmarks Menu item or the associated Keyboard Shortcut ⇧⌘D:

2 Later in this document we will discuss third party Read It Later services which 
provide enhanced functionality over what Safari offers.
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To view web pages saved to the reading list you must first open the Safari 
sidebar.  To do so either:

1. Click on the Show sidebar button  in the toolbar (if displayed)
2. Use the menu bar View→Show Reading List Sidebar item or the Keyboard 

Shortcut ⌃⌘2:

This will open the Sidebar.  Ensure the Reading List is open if you used the 
first option.  The Spectacles tab should be highlighted.  If not click on the 
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Spectacles tab button.  The Reading List will now be open:

To view a Reading List page simply Click on the article in the Reading List 
and the page will be displayed.

Optionally you can right-click or ⌃Click on any article in the Reading List to 
display the options available:
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Note: It is through this menu that you can save offline or remove a page saved to 
the Reading List.

There is also an option available in the Safari Preferences→Advanced tab that 
automatically saves all Reading List articles for offline reading:

Note: This feature is off by default as each saved page will take up space on your 
hard drive.  If you have a machine with a small SSD drive — especially a laptop 
— you want o carefully manage your offline Reading List to ensure you do not 
fill up the drive.

Reader View
Safari Reader View enables you to view a webpage article in a “clean” page, 

formatted for easy reading, and presented without ads, navigation, or other 
distracting items. You can adjust font, font size, and background colour for 
Reader.

Not all web pages can be displayed in Reader View.  For pages that can, a 
Reader View a “Reader Button” will be displayed in the Smart Search field of 
Safari:
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To display in Reader View click on the Reader Button.  The page displayed 
will change into Reader mode:

Note that the Reader Button has been inverted.  To change back to regular 
page view mode click on the Reader Button again.

You can configure Reader Mode options by ⌃Clicking (or Right-Clicking) on 
the Button:

Selecting the first option, “Use Reader Automatically on “websiteURL”, will by 
default display all eligible pages on that web site in Reader Mode.

Selecting the second option, “Reader Websites Preferences…”, will open the 
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Safari Preferences→Websites→Reader tab:

Here you can manage automatic use of Reader for the current website as well 
as all websites previously configured to display in Reader Mode.

To modify the font, font size, and background colour of Reader, click on the 
AA button which is displayed on the right hand side of the Safari Smart Search 
field when displaying in Reader View mode:

A pop-up pallet will appear with the available formatting options:
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For example, changing the background to the slate colour results in:

Changes made using this pallet will apply to the current and all future pages 
displayed in Reader Mode (any Reader Mode pages currently displayed in other 
tabs will not be updated with the modified format).

Note also that Reader Mode is available for pages saved in the Reading List.

Night Shift
Note that Night Shift was introduced with macOS High Sierra (10.13) and is not 
available on earlier version of macOS.

Make things a little easier on the eyes (and sleep a little better after a late night 
session on your Mac?) by using Night Shift.  

Scientific studies indicate that exposure to light in the “cooler colours” (more 
towards the blue or ‘cool’ end of the spectrum) in the hours immediately prior to 
sleep impair your ability to fall asleep quickly and to stay asleep.  Night Shift 
adjusts the colour of your Mac’s display towards the red or ‘warm’ end of the 
spectrum, thereby lessening the impact to your sleep cycle of prolonged staring 
into a bright shiny display just prior to sleep.
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Turn Night Shift on by going to System Preferences→Displays→Night Shift:

Selecting Sunrise to Sunset causes the Mac to use your location and the time 
of day to determine when to start and stop.  Selecting Custom allows you to pick 
fixed start and end times for enabling Night Shift:

Alternatively you can turn Night Shift on or off manually by flipping the 
button at the TOP of the Today slide out dialog:
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Dictation
Did you know that the Mac includes built in voice dictation software?  Using 

it you can talk at your Mac and it will transcribe your voice into text.  This will 
work anywhere that you can enter text from the keyboard, applications do not 
need to do anything special to support dictation.  While there are restrictions on 
some of the things it can do (Nuance’s Dragon suite of dictation software is a far 
more complete product), and the accuracy is not perfect, you can accomplish a 
lot with it.

Enable Voice Dictation
To enable Dictation open the System Preferences→Keyboard→Dictation tab:
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Set Dictation to On to enable the Dictation feature.
If you select “Use Enhanced Dictation” your Mac will download a rather large 

(> 1GB?) file with all the updates necessary to support “continuous” local 
dictation as well as supporting dictation while you are off-line.  If you do not 
select Use Enhanced Dictation you are (essentially) using “Siri Dictation” and all 
audio is sent to Apple’s Servers at one of their data centres for processing before 
the resulting text is sent back to your Mac.

Set the Shortcut — this is the keypress(es) you make to start and stop 
dictation — to a desired value (the author uses Press Right Command Key 
Twice).

Be sure to read the “About Dictation & Privacy…” notice if you are at all 
concerned about Apple ‘listening to you’.
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Dictation Commands
Voice Dictation recognizes a large number of commands while you are 

dictating.  Items like punctation, typography, formatting, capitalization, and et 
cetera can all be managed by speaking specific commands while dictating.  
Recent releases of Dictation on macOS support over 65 such commands.  The 

complete list of supported commands can be found by clicking on the  in the 
lower right corner of the System Preferences→Keyboard→Dictation tab.  In the 
Help screen that opens, click on Commands for dictation text under See also at 
the bottom of the screen (you will have to scroll down to get to See also).  Here is 
a excerpt from this Help page:
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To execute any command just speak the Command phrase while dictating and 
the indicated Result will be inserted into the text transcription.

Using Voice Dictation
Before you start dictation, place the cursor at the point where you want your 

dictated speech to be inserted.
To start dictation press the shortcut key combination (or Edit→Speech→Start 

Speaking in most apps).  After a short pause (or a longer pause the first time you 
use the system after logging in) a tone sounds and a small feedback window will 
appear indicating that dictation is in operation:
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The microphone in this dialog is live and fluctuates to indicate the audio 
loudness level being monitored by the microphone(s) on your Mac.

At this point you can begin dictating.  If you have enabled Use Enhanced 
Dictation after a pause while the system is processing you speech, the text will 
start to be transcribed at the current cursor insertion point. Speak in a clear voice 
at a measured pace.  Over time you will should develop a reasonable feel for how 
fast you can (or cannot) speak.

If you’re using Enhanced Dictation, you can use the keyboard, mouse, 
trackpad, or verbal commands to edit as you go.  If you’re not using Enhanced 
Dictation, and you start editing, your dictation session stops.

To stop dictation press the Done button in the Dictation feedback window or 
press the shortcut key combo again.

Accessibility Features
Voice Dictation also integrates with the Mac’s built-in Accessibility features to 

allow (limited) voice control of your Mac.  
Note: Details of these accessibility features are outside of the scope of this 
document.  The following is the briefest of introductions.  Please consult the 
applicable Mac documentation for details.

You can obtain a list of all the Dictation Commands by going to System 
Preferences → Accessibility → Dictation and clicking on Dictation Commands…
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You can set a keyword phrase (similar to “Hey Siri” on your iPhone) to enable 
voice commands. Check the “Enable…” box and enter a phrase (“Hello 
Computer!”).
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Alfred 3

Alfred 3 is an application that is “always on”, running in the background, 
monitoring your keypresses (and NO, it does not record your actions and send 
them off to some site where it can use it for nefarious purposes), and acting upon 
them to improve your Mac experience.

The central idea behind Alfred is “keep your hands on the keyboard doing 
useful things” and not going back and forth between the keyboard and your 
mouse or trackpad.  In this way your productivity should improve as you are not 
constantly moving between your keyboard and your pointer device.

Alfred is a freemium application, with several useful features locked away 
behind a one-time (per major release) purchase.

Note that there is nothing “similar” to Alfred for iOS … Alfred takes 
advantage of macOS features that Apple has deliberately NOT enabled in iOS.

Download
You can download Alfred from https://www.alfredapp.com 

Warning: Do not download/purchase the (older) version of Alfred available on 
the Mac App Store.  This release was last updated in 2012 and is Version 1 
vintage (Alfred is now at Version 3).  Given the deep integration of Alfred into 
macOS and, Apple’s evolving restriction on what an app sold on the App Store 

https://www.alfredapp.com
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can and cannot do (“sandboxing”), the more recent Alfred 3 cannot be made 
available via the Mac App Store.

Updates
By default Alfred will periodically check for updates.  The ability to turn on or 

off automatic update checking (and the ability to install pre-release “beta” 
versions of Alfred) is available in the Preferences→Update.

Menubar Item
While running, Alfred will install a menubar item: the silhouette of a bowler 

hat.  Click on this to display a drop-down of information and actions:

Toggle Alfred Open the Alfred input dialog.
Alfred Version Information about the version of Alfred running.
Preferences… Opens the Alfred Preferences window.  See the next 

section for a complete walk through.
Check for 

Updates…
Manually check for updates.  Automated updates 
configured in Preferences→Update.

Quit Exit the Alfred application: will no longer respond to 
hot keys.
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Help & Update
Links to several useful web resources are available in the Alfred 

Preference→Help panel.  Clicking on any of the icons in this pane will open the 
indicated resource in your default browser:

Features
Alfred provides a core set of features for free, and additional premium 

features (through the purchase of a “Powerpack”) that can be unlocked via a one-
time fee.

Free Features
The following core functionality of Alfred is available at no charge when the 

application is downloaded:



55

Find Apps & Files
This is the “core” feature of Alfred.  Press a hot key combination and then 

type what you are looking for into the floating dialog that appears:

I use ⌃␣ as my hot key combo.  ⌘␣ is also popular, however this is the 
default hot key for Spotlight so if you choose that and still want hot key access to 
Spotlight you will need to remap the latter’s hot key.  

After pressing the Alfred hot key(s) start typing a string identifying or 
describing what you are looking for:
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Alfred will do its best to display a list of possible actions.  Observe the action 
command hot key combos on the right hand side of the dialog:

◆ ↩︎ selects the currently highlighted entry.  If you do nothing else, 
this selects the first entry in the list

◆ ⌘2 selects the second
◆ ⌘3 selects the third
◆ Et cetera

You can also cursor down (and up) and then hit enter to select the highlighted 
entry:

Note that the right hand action shortcut changes as you cursor around.  In 
particular, scrolling down reveals that the first entry is now (and always is) 
selectable using ⌘1.

By default Alfred will return 20 entries (you can increase or decrease this 
value using an Alfred Preference), but only 9 are displayed in the dialog.  You 
cursor up and down (or Page up and down) to see additional items.  Here I 
cursored down 4 past the “bottom” of the originally displayed list (a total of 12 
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down arrow key presses):

Alfred searches are refined with each new character you enter.  Type in 
additional characters to narrow down the results.  Say I am looking to launch 
“Pages”, I start typing “pages” into Alfred … “p”: 
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Hmm.  No sight of Pages so far … “pa”:

Close, but can I do better?  … “pag”:



59

Got it!  At this point Alfred has identified Pages as the most likely result that 
the user is looking for.  You can now launch Pages by just hitting ↩︎.

Alfred prioritizes search results based on past behaviour.  In the above 
example, when the search term is “pa” LastPass is displayed before Pages due to 
the fact that I have launched LastPass more often than Pages.  Alfred is 
constantly learning your preferences and refining its search results based upon 
such past behaviour.

There are a host of options and controls available for App & Files search.  
Details are available on the Alfred website:

Default Results: https://www.alfredapp.com/help/features/default-results/   

File Search Results: https://www.alfredapp.com/help/features/file-search/  

See Preferences→Features→Default Results and Preferences→Features→File 
Search for configuration details.

Web Search
The Web Search feature makes it easy to quickly launch web searches from 

https://www.alfredapp.com/help/features/default-results/
https://www.alfredapp.com/help/features/file-search/
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Alfred.  It provides a wide range of default web searches for popular sites from 
Facebook, Google and Twitter to Amazon and Wikipedia.  

Web searches are launched by prepending the search terms with a keyword.  
To search Wikipedia you prepend “wiki” to the search term:

Pressing ↩︎ will open a new page in your default browser with the search 
results:

Details, including a list of many of the supported keywords, are available on 
the Alfred website:

Web Search Results: https://www.alfredapp.com/help/features/web-search/ 

See Preferences→Features→Web Search for the complete list of supported 
keywords and for configuration details.

Web Bookmarks
Alfred can return results from your Safari and/or Google Chrome bookmarks.  

You can choose to either include bookmarks in your default results (more 
convenient) or prefix the search with a keyword (lower results noise), which is 
"bm" (for “bookmark”) by default:

https://www.alfredapp.com/help/features/web-search/
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Typing ↩︎ will open the bookmark in a new browser window.  Where multiple 
bookmarks match the query a list will be returned and you can press ↑ or ↓ and 
then ↩︎ or the appropriate ⌘n key to open the bookmark:

Details are available on the Alfred website:
Web Bookmark Results: https://www.alfredapp.com/help/features/
bookmarks/

See Preferences→Features→Web Bookmarks for configuration details.

Calculator
Alfred includes a built in calculator so you do not need to launch an app for 

many/most calculations.
It can do simple math calculations like add (+), subtract (-), multiply (*) or 

divide (/):

https://www.alfredapp.com/help/features/web-search/
https://www.alfredapp.com/help/features/web-search/
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It can also do fancy mathematical formulae:

This is still a fairly simple feature, with no memory or history functions like 
your desk calculator or most calculator apps; but it is fast and readily accessible.    
You can perform the following mathematical calculations with it by prepending 
the “=“ sign: 

sin asin sinh asinh
cos acos cosh acosh
tan atan tanh atanh
log log2 ln dtor
exp ceil trunc rtor
abs floor rint
sqrt round near

You can create complex calculations like a scientific calculator by using 
brackets — “(“ and “)” — to group sub-parts of the equation.

To copy the answer into your clipboard just hit ↩︎ and then type ⌘V (or use 
Alfred’s clipboard feature — see below — to access previously saved results) to 
paste the results into any current input context.

If you're making calculations involving currency symbols (the Dollar, Pound, 
Euro signs for example), Alfred will ignore the symbols, so you can paste directly 
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from the web or spreadsheet you copied your figures from into Alfred without 
having to remove the currency signs first!  

Details are available on the Alfred website:
Calculator: https://www.alfredapp.com/help/features/calculator/

See Preferences→Features→Calculator for configuration details.

Dictionary
Alfred provides access to the default macOS dictionary to help you quickly 

spell a word or determine its meaning.  You use the keywords “spell” and 
“define” to access these features:

https://www.alfredapp.com/help/features/web-search/
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In either case, pressing ↩︎ or the appropriate ⌘n key(s) will open the built-in 
dictionary to the indicated entry:

While it does not provide a thesaurus feature, the easiest way to reach the 
Thesaurus within Alfred is to use the keyword "define" followed by a word you'd 
like to look up. Pressing return on the result then takes you the Dictionary app 
where you can switch between Dictionary, Thesaurus, Apple and Wikipedia.

Details are available on the Alfred website:
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Dictionary: https://www.alfredapp.com/help/features/dictionary/

See Preferences→Features→Dictionary for configuration details.

System Commands
Alfred provides direct access to a number of system commands that you 

otherwise have to open an application or “mouse around” in the Apple menu to 
access.  The supported system commands are:

Screen Saver Lock Quit All (applications)
Show Trash Restart Eject (mounted volumes)
Empty Trash Shutdown Eject All (mounted volumes)
Log Out Hide (applications) Volume Up
Sleep Quit (applications) Volume Down
Sleep Displays Force Quit (applications) Toggle Mute

By entering a keyword into the Alfred search dialog you can activate the 
system command associated with the keyword.  For example, to activate the 
Screen Saver press the Alfred hot key combo and then start typing the keyword 
string for activating the Screen Saver (“screensaver”).  When sufficient letters 
have been typed to unambiguously identify the command you can then press ↩︎ 
to activate the macOS screen saver feature:

https://www.alfredapp.com/help/features/web-search/
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Details are available on the Alfred website:
System Commands: https://www.alfredapp.com/help/features/system/

See Preferences→Features→System for configuration details.

Usage
Curious to find out which Alfred features you use the most? Are you a 

hotkeys type of gal or an iTunes kind of guy? Is Clipboard History your saviour?  
If you answer YES to any of these questions, go to the Usage tab in Alfred's 
Preferences to see a total of your usage since you installed Alfred, and see a 
pretty graph of usage for the last 28 days:

https://www.alfredapp.com/help/features/web-search/
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See Preferences→Usage.

Powerpack Add-On
Purchase the Alfred “Powerpack” add-on to unlock the following 

functionality:
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This is an all or nothing add-on … you cannot pick and choose a subset of 
these features.

There are three pricing options available for purchasing the Powerpack:
◆ Single License: £19 (approx. CAD $33) — all of the Macs you 

personally own
◆ Family License: £29 (approx. CAD $50) — all family members under 

one roof
◆ Mega Support: £35 (approx. CAD $61) — includes free lifetime 

upgrades for a single user 

Clipboard
NOTE: By default the Clipboard is disabled for privacy reasons. Before you can 
start using the Clipboard History feature, you need to enable it.  This is done 
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through the Preferences→Clipboard.

Alfred provides enhanced access to the Mac’s clipboard.  The clipboard is 
where your Mac stores the text, images, files, etc, that you save when you 
“Copy” or ⌘C a selected item.  Normally you only have access to the most 
recently copied item.  Alfred provides a history of a user configurable number of 
clipboard items.  This way you have access to previously copied items which 
would otherwise have disappeared from your clipboard.

The number of items retained by Alfred is managed based upon time since the 
item was saved.  Alfred provides the following clipboard retention windows:

◆ 24 hours ◆ 1 month
◆ 7 days ◆ 3 months

with the ability to set separate clipboard retention times for each of: 

◆ plain text
◆ images
◆ file lists

Press the Alfred Clipboard hot key (default ⌥⌘C) to open a history viewer of 
items saved:
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Note that the first item offered is always access to a listing of all Snippets (see the 
next section of this document).  Use this option to open a Snippet browser, useful 
if you cannot recall a specific Snippet’s shortcut.

The icon to the left of each entry is the application from which the data was 
clipped.  Files are prepended with the keyword “File:”.  Images are prepended 
with the keyword “Image:”.  Text has no keyword prepended.

As you scroll through the list you will see a preview of the saved clipboard 
value on the right hand side of the window.  Once you have selected the item 
press ↩︎ (or press ⌘N for direct access to any of the first nine items on the list) to 
paste the item into the current input context.

As an alternative to the clipboard hot key combo (I.e., if you forget the 
combo), you can press the standard Alfred hot key(s) and type in a user-
configurable keyword (default is “clipboard”) to open the clipboard history 
viewer.
Text

As you scroll through the clipboard history and highlight saved text, the right 
hand side of the dialog shows the saved text:

Images
When you highlight an image, it is previewed in the right hand side of the 
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dialog:

Files
When you highlight a file, a preview of the first page of the file is displayed in 

the right hand side of the dialog (there is no ability to preview additional pages 
of the file, only the first page is displayed):

Details are available on the Alfred website:
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Clipboard History: https://www.alfredapp.com/help/features/clipboard/

See Preferences→Features→Clipboard for configuration details.

Snippets
We previously discussed snippets under Text Substitutions in macOS Built-In 
Productivity Features.  Snippets are saved clips of text that can be inserted into a 
document using a shorter alias string.  

As with macOS Text Substitutions, in Alfred Snippets are defined by the user 
— there are no pre-defined snippets included.  Be aware that there is no ability to 
format the text … snippets are plain text.  About all you can do is include 
newlines and white space in the snippet to be inserted.

I use snippets to insert “standard” or common text strings like:
◆ Dates and times
◆ Email addresses
◆ Street addresses
◆ Phone numbers
◆ Postal codes
◆ Email signatures
◆ … anything I must enter on a regular basis

For example, I use the snippet ‘!ymd’ all the time to insert the current date in 
my preferred YYYY-MM-DD format.3   I also use the snippet “!gm” several times 
a day to insert my GMail email address.

Configuration of Snippets is done in Preferences→Features→Snippets:

3 This format allows you to “naturally” and unambiguously sort files by name when all 
names begin with the date.

https://www.alfredapp.com/help/features/web-search/
scrivlnk://4D437EA9-205B-40AE-9D75-58F593EB6999
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Snippets are grouped into Collections.  A Collection is an end-user 
convenience, and is used to organize your snippets in the event you have a large 
number of snippets defined.

In the Snippets preference you can add new Collections (the “+” under the 
Collection column) and new Snippets to a Collection (the “+” under the Snippets 
table).  Adding a new snippet opens the snippet editor:

Select the Collection for this snippet, enter the Keyword — the value that you 
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will type in and that will be replaced by the Snippet body — and then add the 
Snippet text.  At the bottom of the snippet editor is a pick list of built-in snippet 
placeholders.  Click on this to list and add computed values to your snippets:

Experiment with the { } placeholders to see what they can do!

Note for advanced users: Using Alfred’s Workflow feature (not described here) 
you can get really fancy with your snippets (include clipboard contents, run 
scripts, even launch programs and use their output).

Alfred website DOES include some collections pre-made by contributors AT 
NO COST (available by clicking on the “Get Collections…” button in 
Preferences→Features→Snippets).

For complete details on how to configure and use this powerful feature see 
the Alfred website help page at https://www.alfredapp.com/help/features/
snippets/.

Workflows
Workflows are a very advanced feature of Alfred.  As such a detailed discussion 
of Workflows is out of scope for this document.

https://www.alfredapp.com/help/features/snippets/
https://www.alfredapp.com/help/features/snippets/
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Workflows allow you to extend Alfred to accomplish actions and improve 
your productivity beyond out-of-the-box features.  See the Alfred website’s Help 
Page for this feature for complete details: https://www.alfredapp.com/help/
workflows/:

See Preferences→Workflows.

Navigation & Actions
Purchasing the Alfred Powerpack makes available additional File Search and 

Actions features.  All of the following are detailed in: 

https://www.alfredapp.com/help/features/file-search/ 

under Advanced File Search.  See Preferences→Features→File Search for 
configuration details.

File Navigation 
Using Alfred you can navigate through your Mac's file system. This is a great 

way to quickly make your way through folders without having to use the mouse 
to plow your way through the Finder.

To start, open the Alfred search dialog and type either:

https://www.alfredapp.com/help/workflows/
https://www.alfredapp.com/help/workflows/
https://www.alfredapp.com/help/features/file-search/
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/ (forward slash) to take you to your Mac’s root file system folder, or
~ (tilde) to take you to your user home directory.

Next, start typing the first few characters of the next folder or file you want to 
narrow down the search to, or use ↑/↓ to go navigate to the desired folder or file.  
Once highlighted:

◆ If a folder: pressing ↩︎ will open that folder in Alfred.
◆ If a file: pressing ↩︎ will open the file in the applicable default 

application.
Not sure of the file name? Add a * (star) to the start of your search term to 

make it into a wildcard.

File Buffer 
The File Buffer allows you to select multiple files and add them to a buffer. 

You can then take action on all of these files at once!:
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The buffer is controlled by using a hot key combo with the currently 
highlighted file in Alfred's results: 

⌥↑ to add a file to the buffer from Alfred's results
⌥↓ to add a file and move to the next item in your list of results
⌥← to remove the last item from the buffer
⌥→ to action all items in the buffer (opens a list of commands)

⌥ backspace to remove all items from the buffer

Files in the buffer are persistent … that is they remain there until you take 
specific action to remove them.  Therefore you can add one of more files to the 
buffer, perform other actions (with or without Alfred) and then return 5, 10, or 
more minutes later and they will still be in the buffer.

Press ⌥→ and the Alfred dialog will update to display the list of available 
actions:



78

 

File Previews
Alfred presents file previews in the Actions panel, as well as when using File 

Navigation, allowing you to quickly see the contents of your files to identify the 
right one.

However, if you prefer to turn off rich file previews, either for specific paths 
or file types, or for all files, you can configure in Preferences→Features→File 
Search→Previews:
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By default, Quick Look and Previews are enabled, but each one can be 
disabled by unchecking them.

File Actions
Powerpack users can access the Actions panel either by choosing a file in 

Alfred and pressing →, or by selecting a file in Finder (or another application) 
and using the File Selection hotkey (default ⌥⌘\) to open the Actions panel:
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You can modify the File Selection hot key, as well as configure which actions 
are presented in the panel, in Preferences→Features→File Search→Actions panel:

Advanced Feature: Want to add your own custom file actions?  Take a look at the 
Workflow feature (see above) File Action Triggers for details on how you can 
create custom file actions (e.g. to upload files automatically to Dropbox or move 
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them to a specific folder).

Recent Documents
The Recent Documents feature helps you locate the files you've opened last in 

a particular application.
Search for the application you're looking for and press → to show the list of 

file actions for your app:

You'll then see the list of available file actions for it; Recent Documents will be 
at the top of the list. Press ↩︎ to see the list of recent documents opened by the 
application:
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Cursor ↑/↓ and press ↩︎ or press the appropriate ⌘n key combo to open the 
document in the application.

Known issue: this feature is not fully compatible with Microsoft Office and some 
other non-Cocoa (non-native macOS) applications. In these cases, only files 
opened with Alfred will appear in results due to the limitation of the third party 
software.

Quick Look
For any document returned in a search, press the ⇧ key to open in a quick 

viewer.  Press ␛ to close the viewer.  This works for any document type 
supported by the Mac Quick Look feature (text, images, app-specific, etc)

Start the search (select the item if not at the top):
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Press ⇧ to open the file in Quick Look:

When done press the ␛ key to dismiss the Quick Look window.

Control iTunes
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An iTunes Mini Player is accessible via a user-configurable Hot Key.  The hot 
key combo (default ⌃⌘↩︎) will open a dialog that allows you to navigate your 
iTunes library.  When you press the hot key an iTunes mini player dialog opens:

As an alternative to the hot key combo you can open the mini player using the 
Alfred keyword “iTunes” (user defined in Preferences→Features→iTunes):
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In addition to the mini player, several keyword-triggered actions are available 
to control iTunes.  The actions (and their default keywords; specific keywords are 
user configurable in Preferences → Features → iTunes → Keywords) are:

◆ Play (“play”) ◆ Random Album (“random”)
◆ Pause (“pause”) ◆ Max Volume (“volmax”)
◆ Next Track (“next”) ◆ Half Volume (“volmid”)
◆ Back Track (“back”) ◆ Mute iTunes (“mute”)
◆ Previous Track (“previous”)

To execute one of these actions:
◆ Open the Alfred iTunes mini player
◆ Enter one of the commands
◆ Press ↩︎ to trigger the associated action

Details are available on the Alfred website:
iTunes Mini  Player: https://www.alfredapp.com/help/features/itunes/

See Preferences→Features→iTunes for configuration details.

Themes
Alfred provides extensive appearance (“skinning”) configuration capabilities.  

Several pre-defined themes are included with the application and available for 
selection in Preferences→Appearance:

https://www.alfredapp.com/help/features/itunes/
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You can also select any of these as a starting point and modify to your own 
personal taste (or create a new theme from scratch).  Under 
Preferences→Appearance there is an Options button in the lower left corner.  If 
you select this a dialog opens that allows you to modify most elements of the 
Alfred user experience:

Including making the text big and bold:

Details are available on the Alfred website:
Appearance: https://www.alfredapp.com/help/appearance/

See Preferences→Appearance for configuration details.

https://www.alfredapp.com/help/features/web-search/
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1Password
The author does not use 1Password so can provide no additional information on 
this feature.  That said, 1Password is a well respected and very secure password 
manager that has been on several occasions recommended by Apple as a solution 
to the password management challenge.

Alfred provides integration with Toronto-based AgileBits, Inc.’s 1Password 
application to manage your passwords and other confidential information:

Further information on 1Password is available at AgileBits’ website:
https://agilebits.com 

Integration details with Alfred are available on the Alfred website:
1Password: https://www.alfredapp.com/help/features/1password/

See Preferences→Features→1Password for configuration details.

Custom Web Search
The Web Search feature makes it easy to quickly launch web searches from 

Alfred.  Custom searches allow you to setup search queries for sites you use 
regularly, but that are not included in Alfred's default searches.  See 
Preferences→Features→Web Search and the Add Custom Search Button (in the 

https://agilebits.com/onepassword
https://agilebits.com/onepassword
https://agilebits.com
https://www.alfredapp.com/help/features/web-search/
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lower right corner of the Search tab on this dialog) for configuration details:

Details are available on the Alfred website:
Web Search Results: https://www.alfredapp.com/help/features/web-search/ 
under Custom Searches

See Preferences→Features→Web Search for configuration details.

Terminal / Shell
Alfred provides the ability to launch commands in the macOS Terminal 

application.  This action is triggered by a keyword (default “>”).  Follow this 
with the Unix command, and on pressing ↩︎ Alfred will open a new Terminal 
window and execute the command you entered.  For example:

… will open the following Terminal on my iMac:

https://www.alfredapp.com/help/features/web-search/
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Details are available on the Alfred website:
Terminal / Shell: https://www.alfredapp.com/help/features/terminal/

See Preferences→Features→Terminal / Shell for configuration details.

Contacts
Alfred provides direct support for searching your Contacts.  For non-

Powerpack users searching for a Contact will cause Contacts.app to open, 
displaying the details of the contact:

Selecting the desired contact (if there are multiple matches) and pressing ↩︎ 
will open:

https://www.alfredapp.com/help/features/web-search/
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For Powerpack users the contact will open in Alfred’s in-line contact viewer:

You can then use ↓ and ↑ to select the email address, phone number, etc 
displayed in the viewer and then press ↩︎ to act on the selected information:
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◆ For an email address Alfred will launch a new email composer in 
your default mail app

◆ For a phone number Alfred will copy the number to the clipboard
◆ For an address Alfred will open the address in the Map app
◆ Other details are copied to the clipboard

Details are available on the Alfred website:
Contacts: https://www.alfredapp.com/help/features/contacts/

See Preferences→Features→Contacts for configuration details.

Email
Alfred also provides direct support for creating an email.  There are a few 

different ways to launch a new email:
◆ Search for the contact, view their Contact Card as described above, 

and press return on the email address you want to use
◆ Type "email" followed by the name or email address of your contact 

to launch an email to their default address
◆ Select a file in Alfred and choose the "Email to..." action from the 

Result Actions menu
Details are available on the Alfred website:

Contacts: https://www.alfredapp.com/help/features/contacts/

See Preferences→Features→Contacts for configuration details.

Remote
This section is provided for completeness only.  The Alfred Remote app is not 
being actively maintained (no updates since 2015) and the author has never 
investigated the feature.

Running with Crayons (the maker of Alfred) also sells the Alfred Remote app 
on the iOS App Store.  This app is “your personal command centre” for Alfred 
for the Mac.

https://www.alfredapp.com/help/features/web-search/
https://www.alfredapp.com/help/features/web-search/
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Minimum requirements:
◆ Alfred Remote is available for iPhone & iPad on iOS 7 & iOS 8.
◆ Alfred 3.x on 10.9+ or Alfred 2.6+ on OS X 10.8+ is required on your 

Mac
◆ You’ll need the ability to connect both your Mac and your iOS 

device to the same network through wired or Wi-Fi connection.
◆ Some advanced features require the Powerpack for Alfred 2 on your 

Mac.
See the Alfred website’s for further details: https://www.alfredapp.com/

help/remote/.

https://www.alfredapp.com/help/remote/
https://www.alfredapp.com/help/remote/
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Pocket
Overview of Pocket

Quite often saving a web page as a bookmark is insufficient.  A bookmark is 
just a saved web address.  It provides no information about the contents of the 
page.  When you need more than just an address, enter Pocket.

Pocket is a “read it later” service that allows you to save the contents of a web 
page so you can read it later – on any device, at any time.  Pocket is a freemium 
service.  With a free account you can save any and all pages you visit on the web 
for later viewing. Unlike bookmarking a page, in Pocket you can view the actual 
page contents, even when off-line.  Also with the free account you can organize 
and tag your saved pages for better discoverability and take advantage of 
Pocket’s recommendation service to discover articles and pages related to your 
interests.

Going premium extends the service to include a permanent library of your 
saved articles, adds better search capabilities, intelligent auto-tagging, user 
experience customization, and eliminates advertising.  Premium costs USD $4.99 
per month or USD $44.99 per year (a 25% savings vs. the monthly rate).

Pocket is one of the oldest surviving read it later services.  It was originally 
launched in 2007 under the name “Read It Later” as a plugin extension for the 
Firefox browser.  In 2015 it was incorporated as a default feature into Mozilla 
Firefox and then in 2017 the Mozilla Corporation (the parent of the Firefox 
browser) acquired Pocket.

Pocket is available on on the following platforms:
◆ macOS
◆ iOS
◆ Windows
◆ Android
◆ Kobo eReaders
◆ (Most) web browsers

In addition to the above platforms and applications, over 500 applications 
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integrate directly with Pocket, including: Evernote, most Twitter readers, most 
News/RSS readers like Flipboard, and many, many more.  On the Mac (and iOS) 
Pocket also integrates with other applications via Share Sheet extensions.  When 
an application supports Share Sheets it is able to send content directly to Pocket.

The author’s pocket home page:

Some of the most common Pocket (and similar Read It Later services) uses 
include:

1. Capturing large web articles (including video) for later viewing
2. Saving an article on any device (like your computer or smart phone) 

you happen to be using at the time and then reading it later on a 
more convenient device like an iPad

3. Collecting multiple articles while researching a subject of interest for 
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later analysis and processing
4. Sharing web articles across multiple devices running different 

operating systems
If you have any of these needs then a Read It Later service like Pocket is 

probably for you!

Creating an Account
The first step to using Pocket is to create an account.  Go to https://

getpocket.com and click on one of the Sign Up options:

Note: The following assumes the user will sign up with an email account.  You 
will follow a parallel procedure if you sign up using your Google credentials.  

Enter a name, email address and password for the new account, then click on 
Sign Up:

https://getpocket.com
https://getpocket.com
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Shortly after you click on Sign Up, you will receive a confirmation email:

Click on the “Confirm your email” button to activate your account.  Your 
browser should open on your shiny new Pocket home page.  If it does not, go to 
http://getpocket.com.

At this point you should be prompted to install the browser extension; do 
this.  If you are not prompted you can go to http://getpocket.com/add to install 
it:

http://getpocket.com
http://getpocket.com/add
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Once installed a button will be added to your Safari and/or Google Chrome 
browser toolbar:

Install the Pocket macOS App
At this time you should also install the Mac Pocket App.  The Mac App is 

required to access your Pocket archive when you are not connected to the 
internet.

To install the app go to to the Mac App Store, search for Pocket, and install it 
(it is considered one of the Mac “Essentials” apps):

Once installed, the first time you launch the app you will be asked to login to 
your account.  After this the app will remember your login credentials.

Using Pocket
The following only covers some of the essential features provided by Pocket.  

For full details of all available features and how to use them see the Pocket help 
pages at https://help.getpocket.com:

https://help.getpocket.com
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Saving Articles

To save a page to Pocket, click on the Pocket button  in the browser 
toolbar.  After a few moments the Page Saved popup will be displayed in the 
upper right corner of the web page.  On Safari the dialog looks like:

On Google Chrome the dialog looks like (in this example the “…” button has 
been pressed to expose the available options):

On Firefox the Pocket button is integrated into the browser address field:
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If you take no action this dialog will automatically be dismissed after a few 
seconds.  Until it is dismissed you can do the following through this dialog:
◆ Open your Pocket home page (in your default browser)
◆ Remove the page you just added, cancelling the save
◆ Add one or more tags to the saved article (see below for further details on 

using tags in Pocket)
◆ If supported and enabled (see Browser Extension Settings, below), on some 

platforms you will also be presented with recommended articles that are 
related to the one you are saving:

To open a recommended article click on the title and the article will open in 
a new browser window or tab.  To save a recommended article to Pocket click on 
the Save button in the lower left corner.

scrivlnk://EB42E4E6-8574-4CA8-A56D-67F2D1DC23ED
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Viewing Your Saved Articles in your Browser
You can view and managed your saved articles via your browser by going to 

https://getpocket.com.  The first time you visit you will need to log in, however 
most modern browsers remember your login credentials after this.

On Firefox you can access the pocket website directly from the “View history, 
save bookmarks, and more” button:

Once you are logged in you will see your Pocket home page.  Your saved 
articles are presented as cards in the main area of the page.  This is an “endless 
runner” page … as you scroll down articles will be automatically loaded until 
you have displayed all available:

https://getpocket.com
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Along the left hand of the top of the page you can switch between Pocket’s 
major modes:

◆ The  button will always take you to your home page.
◆ Home is your landing page in Pocket.  Your most recently articles 

will be found here with the newest at the top of the list.
◆ Recommended will display a list of articles recommended for you 

based upon the articles you have saved to Pocket.
◆ Explore > will open an new web page that allows you to search and 

explore the “Best of Pocket”.
On the right hand of the top of the page you have utilities and tools:
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(Note that “robo-test-997” is a Pocket account name — the account the author 
used while creating this document.)

◆  Opens an article search tool.
◆  Allows you to manually add a URL to Pocket.
◆  Views your Inbox which holds all Pocket articles sent to you by 

family, friends, and associates (this feature is not discussed in this 
document).

◆   Opens drop down displaying user account 
tools:

On the left hand side is a navigation bar:
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The first three select:
◆ My List — all your current articles.  Articles remain current until 

deleted or archived.
◆ Favorites — all the articles you have marked as a favourite
◆ Archive — all of the articles you have archived after viewing in 

Pocket
The next three filter the articles displayed:

◆ Articles — all articles that do not contain playable video or are saved 
images

◆ Videos — all articles containing a playable video
◆ Images — all saved Images
◆ Tags > — filter by tags (see Tagging Articles below)

To view an article click on it in the main part of the display.  The article will 
open for reading.  In the upper right corner of the article are actions to manage 
the article:

scrivlnk://23A1BDE5-9D3A-42DE-BA6F-A3A0B0D95A50
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◆  Go back the the main article navigation page

◆ Archive the article (removing it from My List)

◆ Delete the article (you will be prompted to confirm deletion)

◆ Edit Tags — add or delete tags to the article (see Tagging 
Articles below)

◆ Favorite the article (you can toggle this on and off by repeated 
clicking on the icon)

If you roll over an article in the main navigation page these same actions will 
appear, allowing you to directly process the article without having to open it in 
the viewer:

Viewing Saved Articles with the Pocket App
You can also view and manage articles saved to Pocket using the Mac App.  

The main benefit of the native app is the ability to view Pocket apps while 
working off-line, disconnected from the internet:

scrivlnk://23A1BDE5-9D3A-42DE-BA6F-A3A0B0D95A50
scrivlnk://23A1BDE5-9D3A-42DE-BA6F-A3A0B0D95A50
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Differences between the Pocket browser view and the Pocket app consist of a 
significantly different UI in the left hand side of the browser:

◆ Major display modes (Home, Favorites, Archive) are selected from 

the  button

◆ Filter modes are found under the Content Filter ( ) button
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◆ Article search is found at the bottom of the navigation bar

◆ Tag filtering is accessible via the  button at the bottom of the 
navigation bar

In addition, the account management features are found in the application’s 
preferences dialog.

One additional feature of the app is the display format ( ) button in 
the main article viewing area which allows you to switch been a clean article-
only display or a complete web page view of the article.

Tagging Articles
Tags provide a method to organize your saved articles.  They can be added at 

the same time that an article is saved to Pocket, or later while viewing the saved 
article.  If you add a tag that does not already exist it will be created for you 
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(watch out for typos!). Once created and assigned you can use tags to filter the 
articles displayed.

Add an Existing Tag While Saving
To add an existing tag while saving an article start typing the tag name in the 

text entry box of the Page Saved dialog:

Pocket will list all existing tags that match the text you type.  Keep on typing 
more of the name to refine the list or use ↓ and ↑ or the mouse/trackpad to select 
one of the listed tags.  If you type in the complete tag name you can then type ↩︎ 
and the tag will be added to the article.  Then press ↩︎ again or click on the Save 
button to save the article to Pocket with the assigned tag and dismiss the Page 
Saved dialog:

Create a New Tag While Saving
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If you type a name into the tag field that does not match an existing tag, you 
can create a new tag by pressing ↩︎ once the complete tag name has been entered:

Add Multiple Tags While Saving
To add multiple tags while saving an article, after you assign a tag but before 

you click on Save just start typing in another tag name, following the procedure 
as described for the first tag, to assign the second tag.  You can repeat this to add 
as many existing/new tags as desired.  Once all tags have been added click on 
Save or press ↩︎ to save the article and dismiss the Page Saved dialog:

Add a Tag to a Saved Article
To add additional tag(s) to a saved article, locate the article in either the 

Pocket app or your Pocket web page.  The following describes the procedure 
when using the Pocket app, at the end of the section we discuss the differences in 
the Pocket web interface.

In the Pocket app, current tags are displayed in the left hand navigation bar:
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To add a tag, click on the article to open it in the right hand main display, then 
click on the tag icon in the upper right corner of the display:

The Add Tags dialog will open.  Using this you can add an existing or create a 
new tag in a manner similar to how tags are added when first adding an article 
to Pocket:
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When you have added all tags click on Save or type in the shortcut (⌘↩︎) to 
close the the Add Tags dialog.  Observe that the added tags are now displayed 
for this article in the left hand navigation bar:

For the Pocket browser page, note that existing tags are not shown in the UI 
like with the Mac app, you must first roll over the article and clicking on the tags 
button:

This opens the Edit Tags dialog and from here you can make any desired 
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changes:

Filter by Tags When Displaying Articles
As mentioned earlier, tags are a great way to filter the articles being displayed.  

In the Pocket app you open the tag filter pop-up by clicking on the tag icon at the 
bottom of the left hand navigation bar:

Click on any of the items in the pop-up to filter what is displayed in the 
navigation bar:
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To cancel the filter click on the “x” next to the tag name.  To change the filter 
click on the tag name to re-open the tag filter pop-up.

In the Pocket web interface, the tag filter pop-up may be opened by clicking 
on the “Tags >” button in the left hand navigation bar:

Getting Help
To open Pocket’s Help pages from the Mac App, in the menu bar click on 

Help→Pocket Help.  This will open https://help.getpocket.com in your default 
browser.

To open Pocket’s Help pages while in the browser you can enter the above 
link or click on Help in the account tools drop down that can be accessed from 

https://help.getpocket.com
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your account name in the upper right hand corner of the page:

Pocket Browser Extension Settings
You can configure certain behaviours and options in the browser extension.  

These include:
◆ Enable and set a keyboard shortcut to save a page to Pocket
◆ Enable the Quick Save service for select web-based services
◆ (If available on the platform) enable the Pocket Recommendation 

service
◆ Access Pocket web resources 

Safari
To access Pocket settings in Safari open the Preferences→Extensions and click 

on “Click me to show Pocket settings:
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A new browser page will open:

Google Chrome
To access browser settings in Google Chrome ⌃Click or Right-Click on the 

browser button and select Options in the popup:
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The options page will open:

Firefox 
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Pocket is a product of the Mozilla Foundations, the same organization that 
created and maintains Firefox.  As such, Pocket is the built-in Read-It-Later 
service of choice for Firefox.  Log into your Pocket account and settings made in 
the web app or the desktop app will automatically be reflected in the browser.


